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Preface

Thank you for purchasing this Sokkia product. The materials available in this Manual (the “Manual”) have been
prepared by Topcon Positioning Systems, Inc. (“TPS”) for owners of Sokkia products, and are designed to assist
owners with the use of the receiver and its use is subject to these terms and conditions (the “Terms and
Conditions”).

@ Please read the terms and conditions carefully.

Terms and Conditions

Preface

Use

This product is designed to be used by a professional. The user should have a good knowledge of the safe use of
the product and implement the types of safety procedures recommended by the local government protection
agency for both private use and commercial job sites.

Copyrights

All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights
are reserved. Do not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute,
or allow any third party access to, any graphics, content, information or data in this Manual without TPS’ express
written consent and may only use such information for the care and operation of the receiver. The information
and data in this Manual are a valuable asset of TPS and are developed by the expenditure of considerable work,
time and money, and are the result of original selection, coordination and arrangement by TPS.

Trademarks

MAGNET®, Sokkia®, and Topcon® are trademarks or registered trademarks of the Topcon group of companies.

Windows® is a registered trademark of Microsoft Corporation. The Bluetooth® word mark and logos are owned

by Bluetooth SIG, Inc. and any use of such marks by Topcon Positioning Systems, Inc. is used under license. Other
product and company names mentioned herein may be trademarks of their respective owners.

Disclaimer of Warranty

EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS
MANUAL AND THE RECEIVER ARE PROVIDED “AS-1S.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY
IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS
DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED
HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE FURNISHING,
PERFORMANCE OR USE OF THIS MATERIAL OR THE RECEIVER. SUCH DISCLAIMED DAMAGES INCLUDE BUT ARE
NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR REVENUE,
OR LOSS OF THE PRODUCT'S USE. IN ADDITION TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS
INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS,
INCONVENIENCE, OR ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE
RECEIVER.

P/N: 1006148-01 iv



Preface

License Agreement

Use of any computer programs or software supplied by TPS and Sokkia or downloaded from a Sokkia website
(the “Software”) in connection with the receiver constitutes acceptance of these Terms and Conditions in this
Manual and an agreement to abide by these Terms and Conditions. The user is granted a personal, non-
exclusive, non-transferable license to use such Software under the terms stated herein and in any case only with
a single receiver or single computer. You may not assign or transfer the Software or this license without the
express written consent of TPS. This license is effective until terminated. You may terminate the license at any
time by destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of
the Terms or Conditions. You agree to destroy the Software and manual upon termination of the use of the
receiver. All ownership, copyright and other intellectual property rights in and to the Software belong to TPS. If
these license terms are not acceptable, return any unused software and manual.

Confidentiality

This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS’ Confidential Information with a degree of care no less
stringent that the degree of care you would use in safeguarding your own most valuable trade secrets. Nothing
in this paragraph shall restrict you from disclosing Confidential Information to your employees as may be
necessary or appropriate to operate or care for the receiver. Such employees must also keep the Confidentiality
Information confidential. In the event you become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a protective order or other appropriate
remedy.

Website; Other Statements

No statement contained at the TPS and Sokkia websites (or any other website) or in any other advertisements
or TPS literature or made by an employee or independent contractor of TPS modifies these Terms and Conditions
(including the Software license, warranty and limitation of liability).

Safety
Improper use of the receiver can lead to injury to persons or property and/or malfunction of the product. The

receiver should only be repaired by authorized TPS warranty service centers. Users should review and heed the
safety warnings in an Appendix.

Miscellaneous

The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in accordance with, the laws of the State of
California, without reference to conflict of laws.

P/N: 1006148-01




Manual Conventions

This manual uses the following conventions:

Convention Description Example

Bold Menu, or drop-down menu selection File » Exit (Click the File menu and click
Exit)

Bold Name of a dialog box or screen From the Connection screen...

Bold Button or key commands Click Finish.

Mono User supplied text or variable Type guest, and click Enter.

Italic Reference to another manual or help document  Refer to the Sokkia Online Help.

Further information to note about system configuration, maintenance, or setup.

performance, data integrity, measurements, or personal safety.

Notification that an action has the potential to result in system damage, loss of data, loss of
warranty, or personal injury.

@ Supplementary information that can have an adverse affect on system operation, system

Preface P/N: 1006148-01 Vi




Introduction

Sokkia’s Atlas receiver is a compact, high-performing, 226 channel GNSS receiver for static and kinematic
applications. The receiver design includes the latest GNSS board technology, which provides optimized satellite
tracking technology. The Sokkia Atlas delivers world-class positioning and navigation capability to your application
by tracking signals with multiple frequencies and multi-constellation satellite systems.

Using full-wave antenna technology, the Sokkia Atlas can receive and process multiple signal types, including the
latest GPS L2C and L5, Beidou B1, B2, and other future® signals. The Sokkia Atlas receiver includes an enhanced
GNSS receiver board that supports 226 channels with universal tracking technology.

GNSS tracking capabilities, multi-frequency RTK, SBAS functionality, extensive communication capabilities,
removable memory for files combine to provide a positioning system efficient, secure, and appropriate for any
survey.

Several unique features, including advanced multipath mitigation, adjustable Phase-Locked Loop (LLP) and Delay-
Locked Loop (DLL), offer a reliable and versatile reception of weak signals even in degraded signal environments.
The receiver also supports advanced algorithms for superior GNSS tracking in high-vibration environments.

The Sokkia Atlas offers complete protection against dust and water ingress, in addition to superior vibration and
shock resistance. The Sokkia communication interface allows you to quickly integrate Sokkia's premium GNSS
performance within new systems and quickly deliver world-class positioning and navigation support to your
applications.

Sokkia Atlas Features

The Sokkia Atlas receiver’s advanced design allows for a simplified setup and premium performance. The Sokkia
Atlas receiver features the following:

¢ A premier multi-constellation GNSS board

* Industry leading full-wave antenna technology

¢ Detachable batteries for extended operation

¢ Internal radio and cellular (optional) modems

* Integrated Bluetooth® wireless and radio technology

* Optional HSPA (3.5G)? cellular technology

¢ Interface for controlling viewing data logging through the LED display I

¢ External power, USB, and serial-data ports
¢ External high-capacity memory card support -3
The Sokkia Atlas is available in the following configurations: - 4 g

¢ Digital UHF 1l radio modem
¢ Digital UHF Il radio modem with HSPA module

Unpacking Your Receiver Kit

This section describes the documentation, standard kit components3, and accessories (depending on your
purchase) that accompany your receiver. When you unpack your receiver kit, verify you received the items listed
in this section. If any items are missing or damaged, contact your Sokkia dealer or Sokkia technical support. See
“Getting Technical Support” on page 3.

1. The Sokkia Atlas receiver is equipped with a GNSS board that is Galileo-ready. Full support of this new constellation and associated
signals will be incorporated into the receiver when the constellation is mature, and ready for commercial use.

2. High-Speed Packet Access (HSPA) cellular module supports faster data rate and is backward compatible with GPRS/EDGE (GSM)
technology.

3. Components in standard kits may differ based on your region. Contact your local Sokkia dealer to inquire about items included in your
regional standard kit and accessories that are available with the receiver.

Introduction P/N: 1006148-01 1
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Power Cable USE Cable Serial Cable |
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Ta_
Carrying Case Warranty Card Receiver Power Cable Sokkia Atlas Reciever

Figure 1: Standard System Components Included with Your Receiver

The Sokkia Receiver Utility (SRU), USB drivers, and Sokkia Atlas Operator’s Manual are available on
o~ the Sokkia Support website: http://sokkiasupport.com/.

Accessories

Sokkia offers a wide variety of accessories (Figure 2) specially designed to improve system flexibility and job
site efficiency. For more details on the optional accessories available for Sokkia Atlas, contact your Sokkia dealer.

e -“"-"-'3% @

Power Supply Unit Modem Antenna Quick Disconnect

Cradle-to-Receiver Cradle-to-Receiver
Charging Cable Charging Cable

Figure 2: Receiver Accessories

1. Components in standard kits may differ based on your region. Contact your local Sokkia dealer to inquire about items and
accessories included in your kit.

Unpacking Your Receiver Kit P/N: 1006148-01 2




Using Sokkia Software With Your Receiver

Use the Sokkia Atlas receiver in conjunction with the Sokkia Receiver Utility (SRU) and MAGNET® Field
applications for a precision positioning solution. Sokkia software enables you to configure the receiver and other
external devices, manage files, collect data, and perform survey and construction work flows.

3
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The Sokkia Receiver Utility (SRU) is a hardware configuration software for receivers and peripheral devices. You
can install it on desktop computers and data controllers, and is available on the Sokkia Support website:
http://sokkiasupport.com/.

MAGNET® Field software for data controllers provides real-time communication, cloud storage, data collection
and exchange, and field solutions, such as topo, staking, roads, calculations, and more.

Getting Technical Support

Before contacting a Sokkia customer representative about any problems with the receiver, see “Troubleshooting”
on page 38 for some solutions that may fix the issue.

Contact your local Sokkia dealer or visit the Sokkia Support website (http://sokkiasupport.com/) for technical
support.

@g For quick and effective support, provide a detailed description of the problem.

When contacting Sokkia for technical assistance, provide the following information for better and faster service:

1. A description of the following:
— Field operation that was being performed when the problem occurred
— Details of the unexpected behavior, symptoms, and any error messages that precede or follow the
problem
— Problem occurrence frequency or patterns

2. Receiver information and configuration settings. For receiver information, click Information in SRU,
select Save to File, enter a file name, and save it to the computer.

3. Specifications of mobile devices and computers used in the field or office exhibiting the problem. These
specifications should include model information, version number, operating system information, memory
and storage capacity, etc.

4. Information about the system software, including the version number and steps to reproduce the problem.

5. A description of the field environment and/or observation conditions when the problem occurred.

Website

The Sokkia website provides current information about Sokkia’s line of products. The support area of the website
provides access to Sokkia field and office software, manuals, frequently asked questions, and so forth. To access
the Sokkia website, visit www.sokkia.com.

The Sokkia Support website also provides complete support, such as news, updates, reminders, training, live
Webinars, and customer service to help you get the information you need.
For more information, visit: http://sokkiasupport.com/.

Using Sokkia Software With Your Receiver P/N: 1006148-01 3




Getting Acquainted

The Sokkia Atlas receiver enclosure is fully sealed and incorporates the GNSS receiver board, antenna, batteries,
memory storage, and wireless communication device.

Receiver Overview

The upper portion of the receiver contains the GNSS antenna, which is enclosed by the radome and securely
surrounded by a shock-absorbing rubber bumper. The receiver's magnesium alloy lower enclosure features an
easy-to-operate display panel, detachable batteries, quick release mounting socket, and data ports.

The Sokkia Atlas receiver has a highly-visible display panel with single-button operation. The display panel enables
you to view the receiver’s operational status. For more information, see “Display Panel Operations” on page 11.

You can locate regulatory and product identification information on the two receiver labels, which are located
inside of the battery compartments. The product identification label contains the serial number and part number.

Getting Acquainted P/N: 1006148-01 4



Cables

The Sokkia Atlas! package includes a power supply cable, a USB cable, and a power adapter. Table 1 describes
the cables included with your receiver, depending on your regional standard kit configuration. Make sure to
contact your local Sokkia dealer to inquire about standard items included in your receiver kit.

Align the keyways when connecting the power/serial cable to the receiver port. Turn the cable lock
///@ clockwise until it clicks to secure the cable in place. To disconnect the cable, turn the lock counter-

¢ clockwise, and then gently remove the cable.
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Table 1. Receiver Cables

Cable Description Cable Illustration

Power Cable

Connects the power supply unit to a grounded
outlet.

U.S.: p/n: 14-008052-01
Europe: p/n: 14-008054-01
Australia: p/n: 14-008053-01
Brazil: p/n:1000475-01

USB Cable

Connects the receiver to an external device
(controller or computer) for data transfer and
receiver configuration.

p/n 14-008070-01

Receiver Power/Charging Cable

Connects the receiver and the power supply unit via
SAE connectors for battery charging.

p/n 14-008016-03

Serial Cable

Connects the receiver to an external device
(controller or computer) for data transfer and
receiver configuration.

p/n: 14-008005-03

Power Supple Unit

Charges the detachable batteries when connected to
a grounded outlet. This unit converts the alternating
current (AC) normally supplied from an electrical
outlet to a direct current (DC) used to charge the
batteries and/or power the receiver.

p/n: 22-034101-01

during surveying. The power supply unit can either be connected to the charging cradle or directly to

v The power supply unit should only be used for charging the batteries. Do not use as a power source
the receiver. For details, see the power related sections in “Power Supply Unit” on page 16.

1. Components in standard kits may differ based on your region. Contact your local Sokkia dealer to inquire about items included in
your regional standard kit and accessories that are available with the receiver.

Cables P/N: 1006148-01 5




Accessories

Sokkia offers a wide variety of accessories specially designed to improve system flexibility and job site efficiency.
For more details about the available accessories, contact your Sokkia dealer.

Modem Antenna (p/n 30-070003-01 UHF 410-440 or p/n 30-050503-01 UHF 450-470): The Digital UHF 11
antenna is a BNC connection.

2m Carbon Fiber Rover Pole (p/n 808016): A durable lightweight rover pole.
Wide Frame Wood Tripod (p/n 751252): A heavy duty tripod.

Tribrach and Tribrach Adapter (p/n 221470100-SURSK and 210160016): These items level the tripod, and
secure the receiver or antenna to the tripod.

Bayonet Adapter for Tribrach (p/n 726036): Precisely centers, aligns, and levels the tripod over a point.
The horizontal spacer inserts into the precision tribrach, and allows the receiver to sit securely on the precision
tribrach.

Quick Disconnect Adapter (p/n 02-850905-01): Connects to the range pole for the receiver to slip into the
top. Using the side clips, the receiver can be quickly connected to/disconnected from the range pole.

Hand-held Controller: Allows the Sokkia Atlas Base and Rover systems to be configured and monitored
directly in the field. You can use the Sokkia Receiver Utility (SRU) to configure the receiver and any Sokkia
field data collection software.

MAGNET and SRU: Can be used to operate the receiver. See the SRU Online Help or field data collection
software for details on set up and operation.

Alligator Clips-to-SAE Cable (p/n 14-008025-01): Connects the charging cradle or receiver to an auxiliary
battery for powering the receiver during survey operations. Used in conjunction with the Power-to-SAE cable
(p/n 14-008016-01).

Cradle-to-Receiver Charging Cable (p/n 14-008072-02LF (0.5 m long): Connects the receiver to the
charging cradle for external power.

Battery Recharger: Charges the batteries. See “Charging the Batteries” on page 16. Contact your Sokkia
dealer to check for availability.

Accessories

1. Contact your Sokkia dealer for availability of the cradle which charges the Sokkia Atlas batteries.

P/N: 1006148-01
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Batteries

The receiver comes equipped with two detachable, rechargeable batteries for powering the receiver. For more
information about using the batteries, see “Managing Power” on page 16.

Detachable
Battery
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Detachable
Battery

Figure 3: Sokkia Atlas Detachable Batteries

Data and Power Ports

The Sokkia Atlas has the following three ports:

* USB - rimmed in yellow; used for high-speed
data transfer and communication between the

receiver and an external device. The body of _

the connector on the corresponding cable is usB Serial ~ Power

yellow. (yellow)  (black) (reld)
)

* Serial Port — rimmed in black; used for
communication between the receiver and an
external device.

* Power — rimmed in red; used to connect the
receiver to an external power source. This port
can also be used to charge the batteries. The
body of the connector on the corresponding
cable is red. |

1]
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External Radio Antenna Connector

The radio antenna connects to the external antenna connector on the Sokkia Atlas radome (Figure 4). The radio

antenna uses a BNC connection.

pajutenboy Sunjan

NN

External k

Antenna
Connector

NS
N

Figure 4:Sokkia Atlas Radome and External Antenna Connector
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Bottom Connector

The bottom connector (Figure 5) connects the receiver to either a standard 5/8" thread pole/adapter or the
quick disconnect. The quick disconnect adapter (p/n: 02-850905-01) connects to the range pole for the receiver
to slip into the top. Using the side clips, the receiver can be quickly connected to/disconnected from the range

pole.

Quick Disconnect
Adapter

Bottom Connector
for Standard Setups

Figure 5: Sokkia Atlas Quick Connector

SD/SDHC and SIM Card Slots

The SD/SDHC and SIM card slots are located under the battery compartments near the base of the dome. For
more information about the SD/SDHC card , see “Memory” on page 35. For more information about SIM cards,
see “SIM Card Slot” on page 10.

Memory
Card Slot is SIM Card
Slot is Here

Figure 6:Sokkia Atlas Card Slots

Bottom Connector P/N: 1006148-01
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SIM Card Slot

The SIM card slot is located to the right of the LED Display Panel inside the battery compartment. It enables
you to install a standard SIM card into the receiver. Once installed, the SIM card provides a unique identification
for the receiver’'s HSPA module and enables the receiver’s HSPA functionality based on the subscribed services
(the receiver board accesses the HSPA module, which accesses the SIM card). The SIM card usually remains
inside the receiver. You can access the HSPA module, with the SIM card installed, via SRU for configuration
purposes. A SIM card can be purchased from a local cellular provider.
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The Sokkia Atlas receiver, equipped with a CDMA module, does not require a SIM card and is only

<//\/>@ approved to work on a Verizon® wireless network. Note the MEID# printed on the Sokkia Atlas unit
or extracted from SRU, and call Verizon to activate service on the CDMA module installed on the

receiver.

The CDMA module is available on-demand in the United States only. Contact your Sokkia dealer for
more information.

SIM Cards

The SIM card must have HSPA support to communicate over a TCP/IP network.

Installing the SIM Card

1. Make sure the receiver is turned off.
2. Remove the detachable battery to the right of the LED Display panel.
3. Carefully insert the SIM card, label-side up, into the SIM card slot located at the top of the battery

compartment.
Once the receiver is turned on, the receiver board will detect the SIM card, and it will be ready to use as

needed.

SD/SDHC and SIM Card Slots P/N: 1006148-01




Display Panel Operations

The LED display panel (Figure 7) enables you to control receiver power and data recording. The LEDs display the
status of the satellite tracking, recording/memory capacity, Bluetooth connections, and batteries. This chapter
describes the different LED blink patterns and what they mean.

Battery

\.FUNCTION

Button Button

Figure 7: LED Display Panel
Power Button

The power button turns the receiver on and off. When turning the receiver on, press the Power button until the
LEDs briefly flash. When turning off the receiver, press the Power button until the LEDs go out.

Press the power
button for about 1
second to turn the

receiver on/off.

Power
Button

Figure 8: Power Button Functions
Receiver Status LEDs

There are four status LEDs to provide you information about the battery life, tracked satellites, memory capacity,
and Bluetooth wireless connectivity. This section describes the color and behavior of each LED.

Display Panel Operations P/N: 1006148-01 11



STAT LED

The tracking status LED displays the status of tracked satellites when the receiver is on.
Table 2. Status LED Patterns

LED Color Description

One blink per tracked GPS satellite.

One blink per tracked GLONASS
satellite.

One blink means no satellite is being
tracked.
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REC LED

The recording LED indicates if data is being written to memory and warns if memory is available for recording.
For a description of the REC LED status when using the FUNCTION button, see Table 7.

Table 3. Recording LED Patterns

Display Description
o> Green Blink: File logging is in progress. Each
blink indicates data is being written to the
SDHC card.
Solid Orange: The receiver is changing
modes.

Orange Blink: The file system is not
accessible.

Solid Red: A fault condition with the receiver
(no more memory, no SDHC card inserted, a
hardware problem, or an improper OAF.

=
-

<//\,>% For more information on REC LED patterns, see “FUNCTION Button/Logging Data” on page 14.

RX TX LED

This LED displays the status of the modem. Table 4 describes the LED colors and patterns for the different
modems available for the Sokkia Atlas receiver.

Table 4. Sokkia Atlas LEDs

Digital UHF I1

No Light Modem is turned Off

Green Flashes (green LED, off, green LED) Modem is in receiver mode

Solid Green A radio link has been established; modem is ready to
receive data

Solid Green plus yellow (green LED, green Modem is receiving data (Yellow during actual reception)
LED + red LED)

Solid Red Modem is in transmitter mode

Red Flashes (rapid red LED, off, red LED) A fault condition has been detected

Receiver Status LEDs P/N: 1006148-01




Table 4. Sokkia Atlas LEDs

Green Blinks (DUHF 11 or SpSp)

)

n

Red then Green (Red LED, off, green LED, Modem is in command mode o
off) )
<

GSM/HSPA g

Solid Yellow (Red LED + Green LED) Modem is initializing g
Green Flashes The modem is on, registered on the network, and is @)
waiting for incoming calls o

)

Solid Red A connection had been established o
~+

Solid Yellow (Red LED + Green LED) The modem is in direct control mode (Daisy Chain) (@)
-

(V)]

Yellow flashes (green LED + red LED, off) an error has occurred (initialization error, wrong PIN code
etc.)

Bluetooth LED

The Bluetooth LED displays the status of the Bluetooth activity. Table 5 describes the activity.
Table 5. Bluetooth LED Patterns

LED Color Description

Blue Blink: Bluetooth is on and waiting for a
connection.

Blue Solid: A single Bluetooth connection is
established.

No light: Bluetooth is turned off.

0108

Battery LED

The Battery LED indicates the remaining charge of each detachable battery. When an external power source is
utilized, the Power button LED turns solid green and begins to blink if the batteries begin to charge. See Table 6
for more information.

Table 6. Battery LED Patterns

LED Color Description

THE RECEIVER IS ON; USING BATTERY POWER
Slow Green Blink (5 sec.): The charge is greater than 85 percent.

o
> Slow Orange Blink (5 sec.): The charge is intermediate.
o

Slow Red Blink (5 sec.): The charge is less than 15 percent.

EXTERNAL POWER IN USE(POWER BUTTON LED SOLID GREEN);BATTERIES ATTACHED®P

Fast Green Blink (1 Sec.): The internal batteries are at greater than 85% capacity; the
batteries are being charged.

the batteries are being charged.

Fast Red Blink (1 Sec.): The internal batteries are at less than 15% capacity; the
batteries are being charged.

o>
S Fast Orange Blink (1 Sec.): The internal batteries are at greater than 15% capacity;
o>

a. The receiver is on or off.
b. You can also charge the batteries using the battery charging cradle. See page “Battery Charging Cradle” on
page 17.

Battery LED P/N: 1006148-01




FUNCTION Button/Logging Data

This button switches the receiver between
information modes and post-processing
modes, starts/stops data recording, and
changes the baud rate of the serial port to
9600. The FUNCTION button enables you
to turn data recording on or off. See Table 7
to learn how to use the FUNCTION button.

Each time data recording is turned off or
on, either a new file opens or data appends

to a particular file.

Press the FUNCTION
button for 1-5
seconds to start/stop

data logging.

O} 0]

FUNCTION
Button

(& == J‘

Figure 9: FUNCTION Button

Table 7. FUNCTION Button Operations and REC LED Status

FUNCTION Key

REC LED

Status

When data recording is off, and the FUNCTION key is...

Not pressed

No light No data recording.
Orange blink Internal file system test in progress.
Red No free memory; hardware problem with data

recording. No SDHC card.

If FUNCTION key

mode is “LED blink mode switch”

Pressed for < 1

Orange

Release to change information mode.

second

If FUNCTION key

mode is “Occupation mode switch”

Orange

No function.

If FUNCTION key

mode is “LED blink mode switch”

Pressed for 1-5
seconds

Green

Release to start data recording (post-processing
occupation mode undefined).

If FUNCTION key

mode is “Occupation mode switch”

seconds

Green Release to start recording (Kinematic or Static post-
processing occupation mode).
Pressed for 5-8 Red Release to turn serial port A baud rate to 9600 bps.
seconds
Pressed for > 8 No light No function.

FUNCTION Button/Logging Data
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Table 7. FUNCTION Button Operations and REC LED Status (Continued)

FUNCTION Key REC LED Status

When data recording is on, and the FUNCTION key is...

Red No free memory; hardware problem with data
recording.

If FUNCTION key mode is “LED blink mode switch”
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Green Data recording started (post-processing occupation
mode undefined).
Not pressed If FUNCTION key mode is “Occupation mode switch”
Green Data recording started (Kinematic post-processing

occupation mode).

Orange Data recording started (Static post-processing
occupation mode).

If FUNCTION key mode is “LED blink mode switch”

Orange Release to change information mode.
Pressed for < 1
second If FUNCTION key mode is “Occupation mode switch”
Orange Release to toggle between Static and Kinematic post-
processing modes.
Pressed for 1-5 No light Release to stop data recording.
seconds
Pressed for 5-8 Red Release to turn serial port A baud rate to 9600 bps.
seconds
Pressed for > 8 No light No function (data recording still on).
seconds

FUNCTION Button/Logging Data P/N: 1006148-01




Managing Power

This chapter describes how to power the receiver, charge the detachable batteries, and use an external power
source.

Turning On/Off the Receiver

To turn on the receiver, press and hold the power button for more than one second until the LEDs briefly flash.
When the receiver is turned on, the receiver’s channels initialize and begin tracking satellites from multiple
constellations (depending on the receiver’s supported features and current OAF).

To turn off the receiver, press and hold the power button for more than one and less than four seconds (until both
the STAT and the REC LEDs are off).

The receiver will draw a small amount of power from the batteries when it is turned off. If the
@@ receiver is placed in storage for a long period, such as a few months, the batteries may become fully
discharged. You will need to use an external power supply or recharge the batteries before use.

Powering the Receiver

The receiver is powered by the detachable, rechargeable batteries or an external power source connected to the
power port. If an external power source is connected, the receiver draws power from it over the battery.

Detachable External Batteries

Each detachable battery provides between 5 and 10 hours of operation, depending on the receiver mode.

To check the status of the detachable batteries, view the BATT LED or check the status using available Sokkia
software.

Charging the Batteries

The batteries are shipped from the factory without power. Fully charge the batteries before surveying. You can
use the power supply unit or the battery charging cradle to charge the batteries.

Power Supply Unit

The power supply unit (p/n 22-034101-01) charges the external batteries when connected to a grounded outlet.
This unit converts the alternating current (AC) normally supplied from an electrical outlet to a direct current (DC)
used to charge the batteries and/or power the receiver.

not expose the power supply to rain or snow. It should only be used for charging the batteries. Do

@ he power supply unit is designed for indoor use only. Do not use in a damp or a wet environment. Do
not use as a power source during surveying.

You can connect the power supply unit to the charging cradle or directly to the receiver. See Figure 10 on page 17.
The power supply has the following specifications:

* input voltage — between 100 and 240 V AC
¢ frequency of input power — between 50 Hz and 60 Hz
¢ output voltage — 12 V DC@2.5 A (30 W)

Managing Power P/N: 1006148-01 16



lanmod 3uiSeuepy

Receiver

Figure 10:Power Supply Unit

<//\>€S Contact your Sokkia dealer for power supply unit availability.

Battery Charging Cradle

The battery charging cradle (Figure 11) connects to a standard power outlet using the power adapter cable and
power cable/power supply unit.

The charger has two ports, one button, and three LEDs.
* The two ports connect the charger to either a receiver or an external power source. The ports charge or drain
the batteries simultaneously.

¢ The STATUS button activates the battery LEDs.
Press STATUS to display the amount of charge for the corresponding battery.

* The two battery LEDs display the percentage of charge in the attached battery:
— A green light indicates a charge greater than 85%.
— An orange light indicates an intermediate charge.
— A red light indicates a charge of less than 15%. Recharge or replace the battery as soon as possible.

* The power LED lights up when the charger is connected to an external power source; such as an electrical
outlet or another power source (12 volt battery).

Two power in/out ports

STATUS =
Button
Battery Battery = &
\_ @ - —/
| | | ]
@ STATUS @ N N n N
Power

)

Figure 11: Battery Charger Cradle with Batteries
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You can also attach the battery charger to a tripod, a belt, or an RTK pole to provide external power to the base
station or rover.

Before using the Sokkia Atlas, fully charge the batteries for maximum operating time.

Battery Charging Temperatures
Charge the batteries only in temperatures between 32°F (0°C) and 113°F (45°C).

lanmod 3uiSeuepy

An optimal charging temperature is between 50°F (10°C) and 77°F (25°C). If possible, charge
the batteries within this temperature range.

Charging Procedure

There are two ways to charge the receiver’s detachable batteries:

¢ while they are attached to the receiver
¢ while they are attached to the charging cradle

If the batteries are attached to the receiver or to the charging cradle, in approximately six hours the batteries
will be simultaneously fully charged.

The Li-lon batteries used in the battery packs should run at no less than 80% capacity after 500 charging cycles.
You do not need to drain these batteries before recharging.

To charge the batteries using the power supply unit:

1. Plug the receiver-to-SAE power cable into the
receiver’'s power input port.

2. Connect the receiver-to-SAE power cable and
the power supply-to-outlet cable to the AC
adapter.

3. Plug the power supply-to-outlet cable into an
available outlet. The batteries are fully charged
after approximately 6 hours.

To charge the batteries using the charging

cradle:

1. Remove the batteries from the receiver and
insert them into the charging cradle.

2. Connect the power cable to the power supply
unit.

3. Connect the SAE connectors on the power
adapter cable and power supply unit.

4. Connect the power adapter cable to one of the
ports on the charging cradle (either port will
charge both/either battery).

Figure 12: Charging Batteries

5. Plug the power supply to an available outlet. The batteries are fully charged after approximately 6 hours.

Leaving the Batteries on Charge

The batteries can be safely left in the receiver or the charging cradle once charging is complete. Doing so will
not overcharge or damage the batteries.

The batteries can also be attached/detached to/from the receiver or charging cradle at any time without
harming the batteries, the receiver, or the cradle. When returning the batteries to the receiver or cradle,
charging is automatically resumed.

Powering the Receiver P/N: 1006148-01



Attaching the Batteries

To attach the batteries to the Sokkia Atlas
(Figure 13):

1. With the battery slightly tipped, place the
bottom of the battery into the bottom of the
battery compartment.

2. Gently push the top of the battery into the
battery compartment until it snaps into place.
Make sure that the clip at the top of the battery
completely snaps into place.

lanmod 3uiSeuepy

Figure 13: Inserting the Sokkia Atlas Batteries

Detaching the Batteries

To detach the batteries from the Sokkia Atlas, so that they can be charged or replaced:

Using the clip at the top of the battery, gently pull down and out to detach the battery from the receiver
(Figure 14).

Figure 14: Detach the Sokkia Atlas Batteries

Surveying While Charging

The user can execute any kind of surveying while charging the internal batteries attached to the Sokkia Atlas
without degradation of performance.

While charging, make sure the air temperature is between +32 °F (0 °C) and +113 °F (+45 °C). This
is important to prevent serious damage to the batteries, the receiver or injury to persons.

Changing the Batteries while Surveying

It is safe to change a depleted battery with a fully charged one while surveying (i.e., on the fly) without turning
off the receiver. Before doing this, make sure the other battery has enough charge to power the receiver while
changing the depleted battery. The surveying will not be disrupted. If needed, repeat this procedure for the
second battery.
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Using an Auxiliary Power Source

In addition to the detachable batteries, you can connect the receiver to an external power source, such as a
vehicle battery with 9 to 21 VDC, to operate the receiver and for continuous use of the receiver if the detachable
batteries become discharged.

lanmod 3uiSeuepy

@ Power input greater than 21 VDC could damage the receiver.

To connect the receiver to an auxiliary battery (Figure 15):

Use the alligator clips-to-SAE cable (p/n 14-008025-01) to directly connect the auxiliary battery and the
receiver’s power port (without SAE).

When powering the receiver using external batteries, set the charger mode to Off; otherwise, the
detachable batteries will also charge, causing operation time to decrease.

1. Connect the alligator clips-to-SAE cable to a 12-volt battery.
2. Connect the alligator clips-to-SAE cable to the receiver’s power port.
3. Turn on the receiver.

From Receiver to Auxiliary
Battery Using alligator clips-to-
SAE cable

4 A
|

Figure 15: Connect an Auxiliary Battery and the Receiver
A single external 12 V, 2.3 A*h battery should run the receiver and modem for about 9 hours and the receiver
for 13 hours.
To connect the receiver to the charging cradle (Figure 16 on page 21):

The charging cradle with extra batteries hooks onto a tripod or belt for a convenient power supply for the
receiver. The part number for the receiver-to-charger cradle cable is 14-008072-02LF.

1. Connect one end of the cradle-to-receiver cable to the charging cradle.
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2. Connect the other end to the power port on the receiver.

The Batteries in the Charging
Cradle do not Charge the
Internal/Detachable Batteries.
The Charging Cradle Powers the
Receiver

lanmod 3uiSeuepy
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Figure 16: Connect the Charging Cradle and Receiver

Insufficient Power

If the batteries become fully discharged and an external power supply is not connected, the receiver will shut
down and automatically save recorded files. To avoid disruptions, check the BAT LED on the display panel for
the battery charge status. See “Battery LED” on page 13 for more information.

If the receiver shuts down due to insufficient power, the receiver and all communication ports become de-
activated.

To restore power to your receiver and turn it back on, do one or all of the following:
* Recharge the batteries.

* Make sure the power cable is correctly connected to the receiver’s port.
a. Align the keyways when connecting the power/serial cable to the receiver port.

b. Turn the cable lock clockwise until it clicks to secure the cable in place.

c. To disconnect the cable, turn the lock counter-clockwise, and then gently remove the cable.
¢ Connect the receiver to a different power source.

Power supplied to the receiver should match the specifications provided by Sokkia on the product.
///QS Failure to comply with these specifications may damage the receiver. See “Specifications” on

¢ page 43.
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Configuring the Receiver

The sections in this chapter describe receiver options, and how to load a new Option Authorization File (OAF),
update firmware, and perform a factory reset. To do this, you will need to use the Sokkia Receiver Utility (SRU)
software that was supplied from the Sokkia Support website (http://sokkiasupport.com/). For information about
installing the software, see the Sokkia Receiver Utility (SRU) Online Help.

Viewing Receiver Information

In the Sokkia Receiver Utility (SRU), the Receiver Info window displays basic receiver information, such as
hardware and firmware versions, RAM size, receiver ID, serial number, etc.

To open the Receiver Info window:

Connect the receiver to a computer and open SRU.

In SRU, connect to the receiver.

Click Device » Application Mode » Receiver Managing.

Click Device » Connect.

In the Connection Parameters window, select the correct serial port, and click Connect.

In the SRU main window, click the Information icon. The Receiver Info window (Figure 17) appears.

o k~wNE

Mame Value |-
i Model GR5+

i Id UDILZIKFT2G

wr Serial Number GR-5 13323000

& Board Version GR5+_3

& GNSS Firmware Yersion 4.6

w8 GNSS Hardware Yersion 230 E

@ Power Board Firmware Yersion 25
w@ Power Board Hardware Version 2

w@ Vendar Topcon

@ Receiver Uptime 2d 20:53:24
¥ CPU Freq., MHz 250

R AM Size, KB 15,334

=IIFlash Memory Capacity, KB 0.00
=IIFlash Memory Available, KB 0.00
E=Flash Memory Free, KB 0.00 ~

Save to File

Figure 17: SRU — Receiver Info
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Loading New Firmware

Receiver board firmware is released as a compressed file that you download and decompress. This file contains
the following two files:

¢ ramimage.ldr — the Receiver board RAM file
¢ main.ldp — the Receiver board Flash file

To upload firmware files to the receiver:

1. Connect the receiver to a computer using the Power and Serial cable receiver accessory (p/n: 100182-01).
2. To connect to the receiver in SRU:

a. Click Device » Application Mode » Firmware Loader.
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b. Click Device » Connect.

c. Inthe Connection Parameters window (Figure 18), select Serial Port and the port name, and
then click Connect.

F" T
% Connection Para mﬂu

Connect Using

[Serial Port - ]

Paort Name
1 \com1 =

Receiver Port
[ External Receiver

serfa

| Connect |

Figure 18: Connection Parameters Window

3. Click the Firmware Loader g icon in the SRU main window. The Firmware Loader window
(Figure 19) displays. This window enables you to upload firmware files to the connected receiver.

4. Make sure Receiver/Modem/Bluetooth is selected in the Device field.

(Recommended) Select Soft Break as the Capture Method.

6. Browse for and select the receiver board’s RAM and Flash files (Figure 19 on page 24).

o
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Device (00]
[Reoeiverﬂdodemﬂuemnm - ] E
Firmware

Loader:  C:\ramimage.ldr

Image:  C:Vnain.ldp
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Capture Method
Soft Break v]

()
0
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’ | Start

Figure 19: Upload Firmware Window

7. Click Start to upload the selected files.
8. Click OK to continue uploading new firmware to the receiver (see Figure 20).

r |

Device
Receiver Modem /Bluetooth - |
Firmware

Loader: E-C:'|,UsersWBaranov'-Documents'|F'\“a'",gr5|:|_—1_1' y |

Image: i-C: \Users\VBaranov\Documents\FWiar5o_4_1'

Capture Method
550& Break

The firmware has successfully been uploaded.

Undating Flash

L
¢ |

Figure 20: Finishing Firmware Upload
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About the OAF

Sokkia issues an Option Authorization File (OAF) to enable the specific options that you purchased. Sokkia’s OAF
system allows you to customize and configure the receiver according to your particular needs, therefore
purchasing only the options you require.

The Sokkia Atlas receiver typically ships with an Option Authorization File (OAF) which allows you to purchase
specific options for the receiver kit. The OAF system allows you to customize and configure the receiver
according to your particular jobsite needs, thereby purchasing only the options you require. There are several
upgrade options available with the receiver that can extend the receiver’s functionality to better suit your job
requirement. Examples of upgrade options are listed below:

* GLONASS L1, L2 signal tracking

¢ GPS L5 signal tracking

* RTK and update rate 20, and 50 Hz (10 Hz standard)
¢ BeiDou B1, B2 signal tracking

Contact your Sokkia dealer or a representative for a complete listing of available options and pricing information.

Checking the Receiver’'s OAF

To use SRU to view the status of the receiver’s options:

1. Connect the receiver to a computer and open SRU. See the Sokkia Receiver Utility (SRU) Online Help for
more information about connecting the receiver to a computer.

2. In SRU, connect to the receiver.

3. Click the Options @ icon in the main window. The Receiver Options window (Figure 21) displays, so

you can view the current authorization options and upload new ones.

About the OAF

== Receiver Options

2l_1olx]

Friendly Name

[Elers

[ElcLonass

Gahleo

[E]eeipou

[Elseas

[Elazss

SateHite Tracking Channel Count
Dua\ Antenna Tracking
Co»op Tracking

| Quartz Locked Loop
Adaptwe PLL
Mult\path Reduction

[Elocnss mode

I [ElrTx Positioning, Hz

|| [E]rT vertical Accuracy Level, cm
RTK Horizontal Accuracy Level, cm
Maxlma\ Baseline Length, km

[E]Hp2 Mode

[Zlo1on Mode
AutoSeed Mode
DmniSTAR Service
Precise Pasitioning Mode
[ner‘tla\ Integration
Pos\tion Update Rate, Hz

[Elmemory, M
[£]1-pPs Timing signal
Evem Markers

Ser\al Port A Max Baud Rate
=

Current
Tracking
11,12, L5
L1, 12, 13
E1, E5, E6
B1, B2
L1, L5
L1, L2, LS, LEX Tracking, LEX Decoding
224

Raw Measurement Update Rate, Hz 100

Positioning

i}
No restrictions
Heading and Pitch
Yes
Yes
VBS, XP, HP, G2
Code, Float, Fixed, Veripos
Yes
100
Interfaces
No Restrictions
Double
Double
460,800

Permanent

72
No
No
No
No
No
0

No
Disabled
999

999
Disabled
Disabled
No

No
Disabled

No
i}

0

No

No
Disabled

Leased

L1, 12, L5
L1, 12, L3

El, E5, E6

B1, B2

L1, L5

L1, L2, LS, LEX Tracking, LEX Decoding
224

No restrictions

Heading, Pitch and Roll
Yes

Yes

VBS, XP, HP, G2

Code, Float, Fixed, Veripos
Yes

100

No Restrictions
Double

Double
921,600

Figure 21: Receiver Options
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Loading an OAF

Juo>

Sokkia dealers provide customers with OAF files. For any OAF related questions, e-mail Sokkia at
options@sokkia.com and include the receiver’s ID and serial number. To obtain these numbers, see “Viewing
Receiver Information” on page 22.

NS

- When connecting the Sokkia Atlas to the Sokkia Receiver Utility (SRU), some windows will display the
2 receiver as a GR-5 connected to TRU. This will change in future versions of the receiver Firmware.
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To load a new OAF:
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1. Follow the steps in “Checking the Receiver’s OAF” on page 25.
2. Right-click on the Receiver Options window, and select Upload OAF (Figure 22).
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=" Recsiver Options _?I J Q él
Friendly Name Current Permanent Leased l
Tracking

[Eleps

[E]cLonass

Gal\leo

[E]seivou

[E]sBas

[Elozss |
SateHite Tracking Channel Count 72 72 72 =
Dua\ Antenna Tracking No No No

Co»op Tracking No No No

Quarlz Locked Loop No No No

Adaptwe PLL No No No N
Mult\path Reduction No No No Il
Raw Measurement Update Rate, Hz 0 0 o

Positioning

[Elocnss mode No No No

RTK Positioning, Hz Disabled Disabled Disabled

RTK Vertical Accuracy Level, cm 999 999 999

RTK Horizontal Accuracy Level, cm 999 999 999

Maxlrna\ Baseline Length, km Disabled Disabled Disabled

HDZ Mode Disabled Disabled Disabled fiefresh I
[Z]oron Mode No No No I
AutoSeed Mode No No No S.aveiluf:l\s

DmmSTAR Service Disabled Disabled Disabled icw > |
Preclse Pasitioning Mode

Inema\ Integration No No No

Posmon Update Rate, Hz 1] 0 0

Interfaces

[E]memory, ms 0 0 0

[2]1-pPs Timing signal No No No i
Event Markers No No No

Senal Port A Max Baud Rate 115,200 Disabled Disabled i |J

= =

Figure 22: Right-click and Select Upload OAF

3. Navigate to the location of the new Option Authorization File.
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4. Select the appropriate file, and click Open (Figure 23).

o =
—|| b GRS :|_&£ Eearch GR-5

Organize v New folder = - O 0

Juo>

NS
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B Desktop | _UNIVERSAL _Digest_12-14-2013.tpo 12/4/2013 1242 PM  TPO File
'3 Downloads

\ =+ Recent Places
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| Documents
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0
0
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<
®
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File name: UNIVERSAL Digest 12-14-2013.tpo - lOptions Files (*.tpo) vl

|
i Open |VI Cancel ]
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Figure 23: Load OAF

Sokkia’s SRU initially checks to see if the selected file is compatible with the currently connected receiver. If you
chose a file not intended for this receiver, the Upload OAF window displays an error icon next to the Receiver
ID and disables the Upload the File to the Receiver button.

5. Click Upload the File to the Receiver to start loading the file (Figure 24).

= wpiood onr

[,
Property Value |~
Eﬂwner e
[Flserialie na !
[Freceiverd  _UNIVERSAL_ |
=] Model XC00000¢-XX Universi _ |||
! Echecksum 4739 =
| EDeaIer Topcon Positioning Syste |
! EEmaiI IMullen@topcon.com |
|| ] submitTime 2013-12-04 20:40:18 |
ECipher Digest |
EComments Topcon Universal File = |
M« | i | r e
| I
[ Upload the File to the Receiver |
—

Figure 24: Upload the OAF to the Receiver
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6. Click Yes at the prompt to reset the receiver (Figure 25).
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Figure 25:Reset Receiver
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When the receiver resets, the Connection Parameters window opens.
7. Click Connect (Figure 26). The SRU main window opens.

-
5 {hlledinnPammemH

Connect Using

| serial Port v|
Port Name
\\.\COM4 (MOXA Port 2) B

Figure 26:Connect to the Receiver
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8. Click Options (Figure 27). The Receiver Options window displays.
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Figure 27:Click Options

In the Receiver Options window (Figure 28), ensure the following are correct:

¢ |f you uploaded a universal OAF, make sure the expiration date is still valid.
* If you uploaded a customer OAF, make sure the correct customer file is loaded.

" Receiver Oplions 2| _ ol x|
Friendly Name Current Permanent Leased
Tracking
GPS L1, 12, L5 L1, 12,15
[ElcLonass 11,12, L3 L1, 12,13
[E]catieo E1,ES, E6 E1, E5, E6
[E]seibou B1, B2 B1, B2
[Elseas 1,15 L, 15
|| EJazss L1, L2, L5, LEX Tracking, LEX Decoding L1, L2, LS, LEX Tracking, LEX Decoding
SateHlte Tracking Channel Count 224 72 224
Dua\ Antenna Tracking Yes No Yes
Co'op Tracking Yes No Yes
b .Quartz Locked Loop Yes No Yes
Adaptwe PLL Yes No Yes
I Mult\path Reduction Yes No Yes
| Raw Measurement Update Rate, Hz 100 0 100
Positioning
[Eloenss mode Yes No Yes
I RTK Positioning, Hz 100 Disabled 100
|| RTK Vertical Accuracy Level, cm 0 999 1]
RTK Horizontal Accuracy Level, cm 0 999 1]
Maxima\ Baseline Length, km No restrictions Disabled No restrictions
l g HD2 Mode Heading and Pitch Disabled Heading, Fitch and Roll
D]DN Mode Yes No Yes
AutoSeed Mode Yes No Yes
DmmSTAR Service VBS, XP, HP, G2 Disabled VBS, XP, HP, G2
Preclse Positioning Mode Code, Float, Fixed, Veripos Code, Float, Fixed, Veripos
[nartia\ Integration Yes No Yes
Posmon Update Rate, Hz 100 0 100
Interfaces
Memnry, MB No Restrictions 0 No Restrictions
lfPFS Timing Signal Double No Double
Event Markers Double No Double
Senal Port A Max Baud Rate 460,800 Disabled 921,600

Figure 28:Receiver Options Window
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To view additional OAF details, right-click in the Receiver Options window and select View » Details @)
(Figure 29). o
. : : 3
|[= Receiver Options 2l_|ol x| oa-
Friendly Name Current Permanent Leased | C
Tracking -
[Elers -
[ElcLonass =)
Gal\\en OQ
|=]Beinou
SBAS Refresh '-j_r
QZSS Upload OAF |
Save to File = (D
Satelhte Tracking Channel Count 224
Dual Antenna Tracking Yes hd Ove\ew x
C:rop Tracking Yes No m
Quarlz Locked Loop Yes No Yes n
Adaptlve PLL Yes No Yes m
[E]Muttipath Reduction Yes o Yes -
Raw Measurement Update Rate, Hz 100 0 100 L <
Positioning m
[Elocnss Mode Yes o Yes =
[E]rr Positioning, Hz 100 Disabled 100
RTK Vertical Accuracy Level, cm 0 999 0
RTK Horizontal Accuracy Level, cm 0 999 0
Mammal Baseline Length, km No restrictions Disabled No restrictions
HDZ Mode Heading and Pitch Disabled Heading, Pitch and Roll
ED]DN Mode Yes Ho Yes
AutoSeed Mode Yes No Yes
DmmSTAR Service VBS, XP, HP, G2 Disabled VBS, XP, HP, G2
Fre:\se Positioning Mode
Inemal Integration Yes No Yes
Fosit\on Update Rate, Hz 100 0 100
Interfaces
Memor‘y, MB No Restrictions 0 No Restrictions I
El—PPS Timing Signal Double No Double
Event Markers Double No Double
Senal Port A Max Baud Rate 460,800 Disabled 921,600 i
=

Figure 29:Additional OAF Details
Performing a Factory Reset

The receiver’'s Non-Volatile Random Access Memory (NVRAM) holds data required for satellite tracking, such as
ephemeris data and receiver position. The NVRAM also keeps the current receiver’s settings, such as active
antenna input, elevation masks and recording interval, and information about the receiver’s internal file system.
A factory reset clears the receiver's NVRAM and restores the receiver’s factory default settings.

Although a factory reset or clearing the NVRAM is not recommended as a common practice, there are times
when it can eliminate communication or tracking problems.

After a factory reset, the receiver requires time to collect new ephemerides and almanacs (about 15 minutes).

A factory reset will not delete any files already recorded in the receiver's memory, and the NVRAM keeps
information about the receiver file system.

There are two ways you can perform a factory reset: using SRU and using the LED display panel.

Using SRU to clear the NVRAM:

1. Connect the receiver to a computer, and open SRU. See the Sokkia Receiver Utility (SRU) Online Help for
more information about connecting the receiver to a computer.

2. In SRU, connect to the receiver.
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3. Click the Tools icon £, in the main window.
The Tools window appears, enabling you to reset the receiver and clear the NVRAM.

T =TT |

Reset Receiver

C Factory Reset )

Reset Parameters

=~ After resetting, the receiver will require some time to re-collect data
LY needed to track satellites. Continue?

Reset RTK

19A1929Y 9y} Sun3diyuod

L s Dl M

Power Off

Sleep

Reset VISOR

Figure 30:Tools Dialog Box

4. Click Factory Reset, and click Yes to continue.

Using the LED display panel

1. Press the Power button to turn off the receiver.

2. Press and hold the FUNCTION button.

3. Press and hold the Power button for one second, and then release it while continuing to hold the
FUNCTION button.

4. Wait until the STAT and REC LEDs turn green.

Wait until the STAT and REC LEDs blink orange.

6. Release the FUNCTION button while the STAT and REC LEDs blink orange.

o
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Field System Setup

This chapter describes the field setup of your new receiver, so it is ready for use as a Base, network, RTK Rover,
or static data collector.

Setting Up the Base Receiver

Install a tripod (p/n: 751252) over a known point.

Attach the tribrach, tribrach adapter, and bayonet adapter to the tripod (Figure 31).

Attach the antenna to the modem antenna connector.

Level the tripod and tighten the screws.

Attach any other accessories as needed, such as a back-up power supply.

Measure the height of the receiver from the ground using the tape measure. See “Measuring Antenna
Height” on page 33.

7. View the LED display panel for the receiver’s current status. See also “Display Panel Operations” on page 11.

ok wbhPE

- e—Sokkia Atlas

*

.--'
Q e—Bayonet Adapter
5"
= »g Tribrach Adapter

=

'.—Tribrach

e—Tripod

Figure 31:Attach All Components to the Tripod
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Setting Up the Rover Receiver

1. If needed, attach the quick disconnect to a
bi-pod/range pole.

Use a bi-pod during post-

~ ,@ process surveys to ensure the
- antenna/receiver does not
move during data logging.

™~ Sokkia Atlas Recevier
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2. Attach the receiver to the quick
disconnect. Make sure the receiver locks
into place.

3. If you are not using a fixed height rover ]
pole, measure the height of the receiver D
from the ground. See “Measuring Antenna ﬁ Lock
Height” on page 33. 2

4. Attach the antenna to the antenna ——
connector.

5. Press the power button to turn on the
receiver. The integrated wireless device in
the receiver turns on when the receiver is
powered.

6. View the LED display panel for the
receiver’s current status. See also “Display
Panel Operations” on page 11.

Measuring Antenna Height

The receiver calculates the coordinates of the antenna’s phase center. To determine the coordinates of the
station marker, specify the following:

¢ Measured height of the antenna above the station marker

¢ Method of measuring the antenna height

* Model of the antenna/receiver used

Any necessary antenna phase center adjustments, based on the antenna model, is automatically applied. This
adjustment, when combined with accurately measured height and measurement methods, allows for correctly
computed reference marker coordinates.

To accurately measure the antenna height:

1. Measure the antenna height above the control point or marker, either the slant height or the vertical
height.
You may either measure the vertical height to the Antenna Reference Point (ARP) located at the bottom of
the receiver at the base of the mounting threads, or measure the slant height to the Slant Height
Measurement Mark (SHMM) on the side of the receiver. For ARP and SHMM marks on the receiver, see
Figure 32 on page 34.

2. Record the antenna height, points name, and start time in the field notes.

Setting Up the Rover Receiver P/N: 1006148-01




Measuring Antenna Height

168mm

A =ARP to edge = 79.0
B = ARP to corner = 97.5

LV = Vertical Length
LS = Slant Length

Figure 32: Antenna Height Measurement Points
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This chapter provides general information about memory, recording data, downloading data, and removing files
to free up memory space.

Memory

The Sokkia Atlas is equipped with an external SD/SDHC memory card slot. Although you may install an SD/SDHC
card of any memory size into the slot, the receiver recognizes up to 32 GB of memory. For specific information,
see “SD/SDHC Card Recommendations” on page 55. It is necessary to use recommended SD/SDHC cards to
ensure accurate and reliable data logging and minimize any occurrence of data loss, card initialization, etc. The
Optional Authorization File (OAF) controls the receiver’'s memory capacity. As data is logged to the card, the REC
LED displays the memory capacity status. See “REC LED” on page 12 for more information. To access the raw data
files on the memory cards, see “Managing Files” on page 37.

SD/SDHC Card

The SDHC card slot is located to the left of the LED Display

Panel inside the battery compartment and connects an /\
optional SD/SDHC card to the receiver board to provide '

memory. Once installed, the SD/SDHC card usually remains >
inside the receiver. You can access the data that resides on the

SD/SDHC card via the USB or serial port, or Bluetooth wireless

technology. See “Managing Files” on page 37. A secure digital

card can be purchased at a local computer supply store.

Installing the SD/SDHC Card Card Slot

(for SDHC card)

1. Make sure the receiver is turned off.
2. Remove the detachable battery to the left of the LED
Display panel.

3. Carefully insert the SD/SDHC card, label-side down, into
the card slot located at the top of the battery

compartment.
Once the receiver is turned on, the receiver board will detect the SD/SDHC card, and it will be ready to use
as needed.
- Always initialize the file system on the installed SD/SDHC card before the first use. The Initialization
= procedure is described below.

Initializing the File System

The Sokkia Atlas supports a removable SDHC memory card to log raw data files. The memory card must be
initialized before its first use. Initializing the memory card while in the receiver ensures the card is formatted to
the TPS proprietary file system (TPFS). This file system allows the receiver to create, store, retrieve, delete, and
restore raw data files.

It is also advisable to re-initialize the memory card periodically (e.g., quarterly). This erases any data on the card,
checks for bad blocks, and sets the card up afresh.

The user can use SRU to initialize the file system.
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Initializing the File System Using SRU

1.

w

g
=

Connect the receiver to a computer and run SRU. See the Sokkia Receiver Utility (SRU) Online Help for
more information about connecting the receiver to a computer.

Click the File Explorer icon to open the File Explorer screen.
On the Files tab, press and hold the right mouse button on the file line.
Click Initialize File System.

Initializing the file system of a connected receiver will erase all of the receiver’s data files. A warning
message will appear to confirm the operation.

Setting Recording Parameters

The Sokkia Receiver Utility (SRU) software enables you to set logging parameters, such as logging rate and
types of messages, in which to record data. This software is available from http://sokkiasupport.com, and the
SRU Online Help is available only in the software. See the SRU Online Help for more information. The Sokkia
Atlas is compatible with any Sokkia field software for configuration and recording raw data.

Logging Rates

The amount of memory used to log data depends on the logging rate. For more information about setting
logging rate parameters, see the SRU Online Help.

Recording Data

You can log raw GNSS data to the receiver’'s SD/SDHC card and use the Sokkia Receiver Utility (SRU) or
MAGNET® Office software to download the files to a computer.

To start or stop recording data, use the LED display panel or SRU:

1.
2.

Press the Power button to turn on the receiver.

Wait for the STAT LED to indicate satellites are being Press the EUNCTION

tracked. The STAT LED blinks green for GPS satellites button for 1-5
and amber for GLONASS satellites. A short red blink seconds to start/stop
indicates the receiver has not solved a position. Five data logging.

or more satellites provide optimal positioning.

To begin recording, press and hold the FUNCTION
button, and then release it (between 1 and 5
seconds) when the REC (Recording) LED turns green.

) mao )

Make sure the REC light blinks green. This indicates (Foncrion)
that a file has opened and data collection has —
started. The REC LED blinks each time data is saved

to the SD/SDHC memory card. If the REC light blinks FUNCTION
red, the receiver has: Button

¢ a hardware problem

* no SD/SDHC card installed

¢ an improper OAF (See “About the OAF” on page 25)

You can also select File Explorer » Logs » Start in SRU to begin recording data.

When you have finished recording, press and hold the FUNCTION button until the REC LED turns dark. You
can also select File Explorer » Logs » Stop in SRU to end data recording.

To turn off the receiver, press and hold the Power button until all LEDs turn dark.

<//\/>@ You can also log data using MAGNET® Field software.

Setting Recording Parameters P/N: 1006148-01
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Managing Files

Raw data is recorded as time-tagged measurements in a single raw data file. Each file is recorded to the
receiver's memory, and automatically given a name and a *.tps file extension. You can then transfer a file of
collected data can to a computer with file managing software, such as the Sokkia Receiver Utility (SRU). These
programs allow you to use an automatic naming feature, enter file names, and delete files as necessary. For
more information, see the SRU Online Help embedded in the software.

Downloading and Deleting Files

After completing a survey, download data files to a computer or a controller for storage, post-processing, or
backup. The SD/SDHC cards hold a finite amount of files, so you will want to delete files to increase memory
capacity.

When the memory is full, the receiver stops logging data, and the REC LED turns dark/off, indicating an error
condition. Existing data is not overwritten.

To delete raw data files from the receiver, use a USB, serial, or Bluetooth connection to download the files to a
computer. In SRU, you can select the files you want to delete from the receiver. See the SRU Online Help for
more information.

Once a connection is established, you can download all or some files to a computer or controller and then use
the File Explorer feature in Sokkia Receiver Utility (SRU) to manage the raw data files. For more information
about using SRU to download or delete files, see the SRU Online Help embedded in the software.
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Troubleshooting

This chapter will help you diagnose and solve some common problems that may occur with the receiver.

' Do not attempt to repair equipment yourself. Doing so will void the warranty and may damage the
hardware.

Check This First!

Before contacting your local dealer or Sokkia Technical Support, check the following:
¢ Check all external receiver connections carefully to ensure correct and secure connections. Double check for
worn or defective cables.
¢ Check the receiver’s internal batteries for a full charge.

* Check the power source for incorrectly connected cables, and ensure the power source is valid. See
“Specifications” on page 43 for external power requirements.

* Check the software. Make sure the most current software version is downloaded onto the computer and the most
current firmware is loaded into the receiver. Check the Sokkia website for the latest updates.

* Check Sokkia Technical Support (www.sokkiasupport.com) for the latest updates.
Then, try the following:
* Power on and off the receiver by pressing the Power button or by using SRU (Tools » Reset receiver).

¢ Restore default settings by clearing the NVRAM. See “Performing a Factory Reset” on page 30. This restores the
receiver’s parameters to the factory default settings and erases the almanac and ephemeris files. This action
does not delete data files from the receiver memory.

If the problem persists, see the following sections for other solutions.
Powering Problems

The following are some of the most commonly encountered power problems.

The receiver does not power up
* The battery may be discharged.
— Charge the battery overnight. See “Charging the Batteries” on page 16.
* If you are using an external power source, the cable may be disconnected or damaged.
— Make sure the cable is securely connected and undamaged.
* The receiver may have a defective charger or defective battery.

— If, after changing the battery or connecting an external power source, the receiver still does not power
up, contact your local dealer or Sokkia Technical Support for advice.
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Receiver Problems

The following are some of the most commonly encountered receiver problems.

The receiver cannot establish a connection to a computer or external controller
Cable specific problems:

* The cable is not properly plugged in.
— Unplug the cable, then securely and properly reconnect it to the receiver.

* The cable is damaged.
— Use an undamaged cable. Contact a dealer to replace the cable.

* The USB driver is not installed.
— If you are using a USB cable connection, make sure the USB driver, available from the Sokkia Support

website (http://sokkiasupport.com/).
Generic problems:

* The receiver port used for connection is not in Command mode.
a. Connect the receiver to a computer and open SRU (see the Sokkia Receiver Utility (SRU) Online
Help).
b. Click Receiver Settings » Ports.
¢. Change the Input Mode for the port used for connection to cmd.

The receiver does not lock on to satellites for a long period of time
* The corresponding receiver options may be disabled or expired (L1/L2, GPS/GLONASS must be on to track
satellites).
— Order a new OAF with the desired options activated to enable or extend validity of the corresponding
receiver options. Contact a dealer or visit the Sokkia website for details.
— Refer to the Sokkia Receiver Utility (SRU) Online Help for a detailed description of options.

The receiver tracks too few satellites
¢ |f the survey is conducted near obstructions (tree canopy, tall buildings, and so forth).
— Make sure the Multipath Reduction boxes have been enabled in the field data collection software.

a. Connect the receiver to a computer and open SRU (see the Sokkia Receiver Utility (SRU) Online
Help).
b. In SRU, connect to the receiver.
¢. On the SRU main window, choose Receiver Settings » Tracking » Adv tab. Make sure the C/A
code multipath reduction check box is selected.
* Move to an area free of obstructions, if possible.

The receiver cannot obtain Code Differential and/or RTK solutions
* Incorrect Base coordinates entered.
— Specify the correct coordinates for the Base station using SRU or another suitable field data collection
software.
* There could be some obstruction to the connection.
— Clear all possible obstructions or relocate the Base so there is a “line-of-sight” path to the Rover.
* The corresponding receiver options may be disabled or expired.
— Order a new OAF with the required options activated to enable or extend validity of the corresponding
receiver options.
— Refer to the Sokkia Receiver Utility (SRU) Online Help for a detailed description of options.

Receiver Problems P/N: 1006148-01
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* There are not enough common satellites. In order to obtain a fixed solution, the Base and Rover should track
at least five common satellites.

— Check the elevation masks of the Rover and Base receivers; they should be the same. To do this, on
the SRU main window, choose Receiver Settings » Tracking » Obs.

— Verify there is a clear view of the sky to allow sufficient satellite tracking.
¢ A discrepancy exists between the differential standards used at the Base and Rover receivers.
— Ensure the Base and Rover receivers use the same corrections input/output format:

a. Connect the receiver to a computer and open SRU (see the Sokkia Receiver Utility (SRU) Online
Help).

b. In SRU, connect to the receiver.
On the SRU main window, choose Receiver Settings » Ports.
Double-click on the port to be configured and make sure the input mode of the Rover matches the
format of the Base output mode (i.e. RTCM3).
Poor satellite geometry (PDOP/GDOP values are too high).
— Conduct the survey where satellite visibility is better (low PDOP value).
— Ensure the elevation mask is less than 10 degrees.

— Increase the PDOP threshold. To do this, on the SRU main window, choose Receiver
Settings » Tracking » Obs.
* The elevation mask is above 10 degrees.
— Lower the elevation mask. To do this, on the SRU main window, choose Receiver
Settings » Tracking » Obs.
— Verify there is a clear view of the sky to allow sufficient satellite tracking.
The modem battery is low.

The specified baud rate is incompatible with the baud rates the modem supports. The baud rate is the rate at
which the receiver transmits differential messages to the modem and vice versa.

— Change the modem’s baud rate.
The Base and Rover modems use different radio link parameters.
— Configure the Base and Rover radio modems according to the procedures listed in the SRU Online
Help.
The distance between the Base and Rover is too far.
— Close the distance between the Base and Rover.
— Use repeaters to increase radio coverage.
* There may be a source of radio interference that disrupts radio communications.
— Change the RF channel (if possible).
— Removing the source of the jamming signal or relocate the radio antennas (if possible).
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The receiver does not start logging data

¢ Make sure the recommended SD/SDHC card is being used and that the card is not damaged. See “SD/SDHC
Card Recommendations” on page 55.

* Make sure the SD/SDHC card is properly inserted.
* The receiver's memory is disabled or expired.
— Make sure the memory option is enabled. For details, see the Sokkia Receiver Utility (SRU) Online
Help.
* The memory card does not have free space.
— Download and/or delete data files to free up space for new files. See “Downloading and Deleting Files
on page 37.
— The file system is not initialized. Initialize the File System on the SD card using SRU. To do this, on the
SRU main window, choose File Explorer » Initialize File System.
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Bluetooth Problems

The following are some of the most commonly encountered error messages and other problems.

SRU error message: Can’t find receiver

* The receiver is turned off.
— Ensure the receiver has power and is turned on.
Bluetooth is not turned on; the BT LED is off.
— Reset the receiver to the factory default settings by pressing the Power button for 10 to 15 seconds.
— You can also turn on power to Bluetooth using SRU. To do this, on the SRU main window, choose
Receiver Settings » Bluetooth.
* There is interference.
— Move the receiver, controller, or computer to an unobstructed location.
* The receiver is too far away.
— Move the devices closer together.
* The receiver is already connected via Bluetooth to another device.
— Disconnect the receiver from the other controller or computer.
* The receiver port used for connection is not in Command mode.
a. Connect the receiver to a computer and open SRU (see the Sokkia Receiver Utility (SRU) Online
Help).
b. Click Configuration » Receiver » Ports.

¢. Change the Input Mode for the Bluetooth serial port used for connection to cmd.
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This is the most common cause for this error message. Use SRU to double check the settings for the
~ connection port.

SRU error message: Open COM# port failed: Access is denied
* Another application uses the computer port dedicated for connection.
— Close the application, and then re-connect.
— Connect the receiver via another, unused computer port.

After searching for available devices, none are discovered

* The receiver is not receiving power.
— Check that the receiver is getting power and is turned on.
— Check that the power cable is correctly attached to the port if one is being used.
— Unplug the cable, then securely and properly reconnect it to the receiver.
— If the power cable is damaged, contact a Dealer to purchase a new cable.

Can see the icon for the receiver’s Bluetooth module on the computer screen, but cannot connect to it

* Device security settings probably differ.
— Make sure the Bluetooth enabled devices use the same security settings.
¢ Bluetooth module settings may have changed.
a. If the settings are changed for the Bluetooth module, remove it from the list of discovered
Bluetooth devices using the Bluetooth manager program (supplied with the device used to
manage the receiver).

b. Repeat the search.
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SRU Problems

The following is the most commonly encountered SRU problem.

SRU cannot connect to the receiver

* The receiver is turned off.
— Ensure the receiver has power and is turned on.

¢ |f using a cable, the cable’s connectors are improperly attached.
— Check that the cable connector is attached to the correct serial port.
— Unplug the cable, then securely and properly reconnect it to the receiver.

* If using a cable, the cable is damaged.
— Use an undamaged cable.
— Contact a dealer to purchase a new cable.

¢ |f using Bluetooth wireless technology, the incorrect port is selected.
— Use a computer or receiver that has Bluetooth wireless technology enabled/installed.
— Make sure the computer and receiver use the correct ports for communication. For the Sokkia Atlas

receiver, this is Bluetooth serial port A (btsp\a).

Cleaning and Storing the Receiver

* Use a clean cloth moistened with neutral detergent or water.
* Never use an abrasive cleaner, ether, thinner benzene, or other solvents.

* Always make sure the receiver is completely dry before storing it. Dry any moisture with a soft, clean cloth.

Getting Customer Support

If the troubleshooting hints and tips in this operator’s manual fail to remedy the problem, contact Sokkia
Customer Support. For contact information, see “Getting Technical Support” on page 3.

SRU Problems P/N: 1006148-01
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Specifications

This chapter provides specifications for the receiver and its internal components.

General Details

Table 8 lists the receiver’s general specifications.

Table 8. General Receiver Specifications

Physical
Enclosure Dust and water ingress protected magnesium I-Beam housing
Color Sokkia Grey / Blue bumper

Dimensions (mm)

158.1 (w) x 253 (h) x 158.1 (d)

Weight

1.88 kg with batteries, 1.44 kg without batteries

Antenna Type

Integrated Full Wave Fence Antenna™? with Ground Plane and
zero center

Battery Two external, detachable
Controller External
Mounting 5/8-11, quick disconnect
Seals Silicon (molding in color)
Keys Two keys:
* Power — On/Off
« Function — start/stop data logging; switch information mode
LEDs Six LEDs:

e STAT — satellite and receiver status

* REC - record and data status

* RX TX — modem status

* BT — Bluetooth wireless technology connection status
e BATT (x2) — battery status

Environment

Operating Temperature

» -30°C to +50°C Base*
e -30°C to +60°C Rover*
* -30°C to +60°C Base**
e -30°C to +70°C Rover**

e 0° to +45°C Charge mode*
* with detachable batteries
** with external power source

Storage Temperature

-20°C to +35°C with batteries
-40°C to +75°C without batteries

Humidity

100%

Ingress Protection

Dust and water ingress protection (IP66)

Specifications
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Table 8. General Receiver Specifications

Shock/Bump/Drop Rating

IEC 60068-2-29
IEC 60068-2-27
2 m pole drop to concrete

Vibration

Compliance with MIL-STD 810F - 514.5 - Cat.24

Power

External Batteries

Li-ion, 3900 mAh, 7.2 V; 2 batteries, detachable

Battery Size

132 x 55 x 35 (mm)

Battery Weight

220 g (1 battery)

Operating Time

Average with modem “on”
and 20 SVs tracked.

Using new, fully-charged
batteries, operating at
room temperature and
transmitting at 1 Hz rate.

For the Sokkia Atlas with Digital UHF Il Modem:
* Receive-only mode — 14 hours

Transmitting at 0.5 W — 10 hours

Transmitting at 1 W — 8 hours

GSM/HSPA in urban areas — 12 hours

Modem off — 20 hours

]

]

External Power

1 port

Input Voltage

9 to 21 V DC (for work)
10 to 21 V DC (for charge battery)
Maximum Charge Current <=2 Amp

Power Consumption

”

Average with modem “on
and 20 SVs tracked.

Using new batteries and
operating at room
temperature.

e Modem = off — 3.0W
Digital UHF 11

* Receive-only mode — 4.3 W
* Modem transmitting at 0.5 W — 6.4 W
* Modem transmitting at 1 W — 7.8 W

Battery Charge

Connect the AC adapter to charge the internal battery.
Available run charge when connected to external battery.

Charging Time

Approx. 6 hours for full charge

On-board

Backup battery for timekeeping and almanac data storage;
minimum 10 years of operation

GNSS

Number of Channels

226 channels? with optimized satellite tracking technology

Tracked Signals®

GPS: L1/L2 C/A and P(Y), L1C, L2C, L5
GLONASS: L1/L2 C/A and P full wave carrier
BeiDou: B1 and B2 full wave carrier

QZSS L1 C/A, L1C, L2C, and L5 full wave carrier
SBAS (WAAS/EGNOS/MSAS) L1 code and carrier

Galileo E1, E5a/b, E5 AltBOCH

Tracking

Multipath Reduction

Yes, code and carrier

PLL/DLL Settings

Bandwidth, order, adjustable

General Details

P/N: 1006148-01
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Table 8. General Receiver Specifications

SBAS

WAAS/EGNOS/MSAS

Quartz Lock Loop (QLL)

Protection against vibrations

Data & Memory

Formats TPS proprietary, NMEA 0183, RTCM 2.X, RTCM 3.X, RTCM
MSM, CMR/CMR+, BINEX
Features * Up to 20 Hz update rate for full-wave real time position and

raw data (10 Hz standard)
* 10cm code phase and 0.1mm carrier phase precision
e RTCM SC104 version 3.1, 3.0, 2.3, 2.2, and 2.1 1/0

Type of Memory

Removable SD

Capacity

Up to 32 GB®

Number of Files

up to 3000

Logging Size

3.5 MB per hour (18 SVs, 1 sec, L1/L2, default message set)

Logging Interval

0.02 to 86400 seconds, depending on purchased options

Output

Communication Ports

* High-speed RS232 serial port (rimmed in black)
e USB port up to 12 Mbps (rimmed in yellow)
« Internal Bluetooth (port D)

Serial Port Specifications

RS232 Serial Port:

» Baud rate: 460800, 230400, 115200 (default), 57600,
38400, 19200, 9600, 4800, 2400, 1200, 600, 300

* Flow control: RTS/CTS

e Length: 7 or 8 (default)

« Stop bit: 1 (default), 2

« Parity: None (default), Odd, Even

Connectors

* Modem Antenna (BNC)
e PWR

* RS232 Serial

- USB

MINTER (LED Display)

* 6 external LEDs
* ON/OFF control input (power button)
« Data logging control (FUNCTION button)

NMEA

NMEA 0183 Output

Ver. 2.1, 2.2, 2.3, 3.0 output

Messages

GGA, GLL, GMP, GNS, GRS, GSA, GST, GSV, HDT, RMS, ROT,
VTG, UID, and ZDA

Output Interval

1Hz standard; 10, 20, 50 Hz optional

DGPS

Correction Format

RTCM SC104 Ver 2.1, 2.2, 2.3, 3.0, and 3.1

RTCM Message Type

1, 3,9, 31, 32, 34; user selectable

Process Interval

1Hz standard; 10, 20, 50 Hz optional

General Details
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Table 8. General Receiver Specifications

Output Interval for RTCM 1Hz standard
Correction Data

Elevation Mask 0 to 90 degrees (independent of data logging)

Real-Time Kinematic Mode

%)
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o
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CMR/CMR+ (Trimble compatible), TPS proprietary

Supported RTK Network VRS, MAC, FKP

Solutions

Ambiguity Initialization On-The-Fly (OTF): L1, L1/L2

Baseline Length Up to 50km, depending on atmospheric and multipath
conditions

Initialize Time 1 second to 10 min., depending on the baseline length (D) and
multipath conditions

Output Interval for 1Hz standard

CMR/RTCM

Elevation 0 to 90 degrees (independent of data logging)

Solution Mode Delay (synchronization) mode: 5 to 10 msec
Extrapolation (not synchronized) mode: 10 to 20 msec

Process Interval 1Hz standard; 10, 20, 50 Hz optional

Latency Delay mode: 5 to 10 msec.
Extrapolation mode: 10 to 20 msec.

Status Fix, float, DOP, data link status, modem latency, common
satellites

Results RTK coordinates, HRMS, VRMS

Survey Modes

Base or Rover Autonomous (standalone)

DGPS (w/ user base)

DGPS (w/ SBAS)

Static

Kinematic (continuous, stop and go)
RTK (delay, extrapolation)

Accuracy (RMS)9

Static/Fast Static L1 only:

H: 3mm + 0.8ppm (x D);
V: 5mm + 1.0ppm (x D)
L1+L2:P

H: 3.0mm + 0.1ppm (x D)
V: 3.5mm + 0.4ppm (x D)

Kinematic, RTK L1+L2:
H: 8mm + 1.0ppm (x D)
V: 15mm + 1.0ppm (x D)

General Details P/N: 1006148-01




Table 8. General Receiver Specifications

DGPS User Base:
H: 0.4m
V: 0.6m
SBAS:
H: 1.0m
V: 1.5m
Autonomous Accuracy H: 1.5m RMS
V: 2.0m RMS
Cold Start <60 sec
Warm Start <35 sec
Hot Start <10 sec
Reacquisition <1 sec

a.
b.

(3]

—h D

General Details

Patent pending. Multiple patents are associated with Fence Antenna™ technology.

Includes two dedicated channels for L-Band signal tracking. The Sokkia Atlas receiver does not
support L-Band signal tracking.

Support for L1C signal for GPS and QZSS is incorporated, and will be available through a
firmware upgrade.

. The Sokkia Atlas is capable of supporting E1, E5a/b and E5 AItBOC signals for Galileo. Full

positioning support will be incorporated into Sokkia Atlas when these constellation have
matured and are ready for commercial use, and as support is made available in the firmware.
For more recommendations, see “SD/SDHC Card Recommendations” on page 55.
CMR/CMR+ is a third-party proprietary format. Use of this format is not recommended and
performance cannot be guaranteed. Use of industry standard RTCM 3.x is always
recommended for optimal performance.

Subject to multipath anomalies, interference, atmospheric conditions, and atypical satellite
geometry. GNSS survey best practices must always be applied.

. The stated accuracy and reliability requires nominal observing conditions and strict processing

methods. This includes use of dual frequency GPS measurements, precise (final) ephemerides
during post-processing, calm ionospheric conditions, unobstructed visibility above 10 degrees,
approved antenna calibration parameters, and an observation duration of 3 hours or more
(dependent on baseline length). Accuracy and reliability may be subject to multipath

anomalies and atypical satellite geometry. GNSS survey best practices must always be applied.

P/N: 1006148-01
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Digital UHF Il Internal Modem Board Details (Optional) L
Table 9. DUHF Il Internal Modem Board Specifications (_(_Eh

Operating frequency e 410MHz — 470MHz for Rover é
range * 420MHz — 470MHz for Base g'
Channel spacing 12.5 KHz / 20KHz / 25KHz user selectable a
Signal modulation e 4FSK
Communication mode Time division duplex
Supported protocol(s) Proprietary, PDL, Trimble

Transmitter carrier power 10, 20, 50, 100, 200, 500 and 1000 mW, user selectable

Receiver sensitivity GFSK: -119 dBm at 10~* BER and 12.5 KHz spacing
4FSK: -114 dBm at 10™* BER and 12.5 KHz spacing

Receiver dynamic range -119 to -1dBm

Serial data rate 1200, 2400, 4800, 9600, 14400, 19200, 38400, 57600,
115200 bps

Radio data rate 25KHz: 9600 bps for GFSK and 19200 pbs for 4FSK
12.5KHz: 4800 bps for GFSK and 9600 pbs for 4FSK

Antenna type Whip antenna

Antenna connector BNC

Error correction FEC on/off

Digital UHF 11 Internal Modem Board Details (Optional) P/N: 1006148-01




Optional Cell Module Details L
0
Table 10. Cellular Specifications Qh
Dual Band CDMA 1xRTT Module %
~*
Supported Bands CDMA 800/1900 MHz (@]
3
TX Power 800 MHz — Class 3 (24 dBm) 0
1900 MHz — Class 2 (24 dBm)
Data 1x/QNC/HSPD
CSD, Max BR 14.4 Kbps
AT Command Set N/A
Regulatory and Approvals | CDG1, CDG2
FCC, IC, CCC
EMC
QS9000 manufacturing
RoHS/WEEE

3.5G Wireless Module (Quad-band GSM and UMTS/HSPA)

Supported Bands GSM 850/900/1800/1900 MHz
UMTS/HSPA 850/1900/2100 MHz

TX Power UMTS/HSPA - Class 3 (0.25 Watt)

GSM 850/900 MHz — Class 4 (2 Watt)

GSM 1800/1900 MHz — Class 1 (1 Watt)
EDGE 850/900 MHz — Class E2 (0.5 Watt)
EDGE 1800/1900 MHz — Class E2 (0.4 Watt)

Data Features UMTS/HSDPA/HSUPA 3GPP, Release 6

GSM/GPRS 3GPP, Release 9

Max uplink 5.76 Mbps, max downlink 7.2 Mbps

EDGE, Multi-Slot class 12

CSD, Max BR 14.4 Kbps GSM, Max BR 14.4 Kbps UMTS

AT Command Set GSM 07.05, 07.07

Regulatory and Approvals | FCC, IC
ANATEL (Brazil)
PTCRB
R&TTE/CE

GCF
RoHS/WEEE
ACMA

BABT

Optional Cell Module Details P/N: 1006148-01




Bluetooth Module Details L
Table 11. Bluetooth Module Specifications (_(_Eh
Range up to 10 m (indoor); up to 20 m (outdoor) é
Type Class 2 g
3
Service classes Miscellaneous “n
Supported profiles LM, L2CAP, SDP, SPP
Frequency Country Code North America and Europe
Frequency Country Code North America and Europe
Range up to 10 m (indoor); up to 20 m (outdoor)

Connector Specifications

The Sokkia Atlas has one antenna connector for radio transmission/reception and three port connectors for
power and data upload/download.

Radio (Modem) RF Connector

The modem connector (Table 12) is a BNC connector for UHF radios.

Table 12. Modem Connector Specifications

Signal . .
Modem Type Type Dir Details
DUHFII BNC Modem 1/0 1/0 RF/GSM output
from modem
antenna

Bluetooth Module Details P/N: 1006148-01




Power Connector

Rimmed in red, the power connector (Figure 33) is a sealed receptacle, 5 pin, ODU part number G80F1C-
TO5QF00-0000.

@ ®©

Figure 33:Power Connector
Table 13 describes power connector specifications.

Table 13. Power Connector Specifications

Number Signal Name Dir Details

1 Power_INP P 9 to 21 volts DC input
2 Power_INP P 9 to 21 volts DC input
3 Power_GND P Ground, power return
4 Power_GND P Ground, power return
5 Aux_Power P 9 to 21 volts DC input

Connector Specifications P/N: 1006148-01
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Serial C-RS232 Connector L
¢)
Rimmed in black, the serial RS232 connector (Figure 34) is a sealed receptacle, 7 pin, ODU part number Qh
G80F1C-T07QC00-0000. A
=)
o]
=)
7
@ ® ®

Figure 34:Serial RS232 Connector
Table 14 gives the RS232 cable connector specifications.

Table 14. RS232 Connector Specifications

Number Signal Name Dir Details
1 Not used

2 GND - Signal ground

3 CTS | Clear to send

4 RTS 0o Request to send

5 RXD | Receive data

6 TXD (0] Transmit data

7 Not used

Connector Specifications P/N: 1006148-01




USB Connector

Rimmed in yellow, the USB connector is a sealed receptacle, 4 pin TPS cable connector (Figure 35).
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Figure 35:USB Connector for GGD Options
Table 15 gives the USB connector specifications.

Table 15. USB Specifications

Number Signal Name Dir Details
1 USB_PWR P Bus power input

2 USB D- 1/0 Data minus

3 USB D+ 1/0 Data plus

4 GND P Ground

Connector Specifications P/N: 1006148-01




Product Identification

The Sokkia Atlas receiver can be identified by the serial number range shown in Table 16.

Table 16. Product Serial Numbers

Cellular Modem Serial Number

Sokkia Atlas (With Digital UHF 1I)

No cellular modem 1332-xxxx

HSPA modem 1333-xxxx

Product Identification P/N: 1006148-01 54



SD/SDHC Card Recommendations

This section provides a recommended list of SD/SDHC cards that were tested with the receiver. This list of
recommendations is based on testing results available to date and should not be considered a comprehensive list.
The receiver is capable of working with SD/SDHC cards with a storage capacity of up to 32GB.

For optimal and consistent performance, Sokkia recommends using the SD/SDHC cards listed in this
- section.

Sokkia recommends using the following list of SD/SDHC cards with your receiver:

¢ Swisshit® Industrial 2GB

¢ SanDisk® Ultra Il

¢ Transcends® Ultra Industrial 2 GB
¢ APRO® Industrial 4 GB

SD/SDHC Card Recommendations P/N: 1006148-01 55



Safety Warnings

General Warnings

distances, angles and depths, and recording such measurements). This product should never be used:
¢ Without the user thoroughly understanding this manual.

¢ After disabling safety systems or altering the product.
¢ With unauthorized accessories.

¢ Without proper safeguards at the job site.

¢ Contrary to applicable laws, rules, and regulations.

' Sokkia receivers are designed for survey/construction and related uses (that is, surveying coordinates,

Battery Warnings

Never attempt to open the casing of the detachable batteries! Lithium-lon batteries can be
dangerous if mishandled!

Do not incinerate or heat the battery above 212 degrees fahrenheit (100 degrees celsius). Excessive
heat can cause serious damage and possible explosion.

Tampering with the batteries by end users or non-factory authorized technicians will void the
battery’s warranty.
» Do not disassemble the batteries.
Do not charge in conditions different than specified.
Do not use other than the specified battery charger.
Do not short circuit.
Do not crush or modify.

Receiver Warnings

receiver’'s warranty:
* Do not attempt to open the receiver and modify any of its internal components.
® Do not charge in conditions different than specified.
® Do not short circuit.

' Tampering with the receiver by the end users or non-factory authorized technicians will void the

Usage Warnings

If this product has been dropped, altered, transported or shipped without proper packaging, or
otherwise treated without care, erroneous measurements may occur.

The owner should periodically test this product to ensure it provides accurate measurements.
Inform TPS immediately if this product does not function properly.

' Only allow authorized Sokkia warranty service centers to service or repair this product.

Safety Warnings P/N: 1006148-01 56



Regulatory

The following sections provide information on this product’s compliance with government regulations for use.

FCC Compliance

This equipment complies with FCC radiation exposure limits set forth for uncontrolled equipment and meets the
FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65. This equipment has very low levels of
RF energy that it deemed to comply without maximum permissive exposure evaluation (MPE). But it is desirable
that it should be installed and operated with at least 30cm and more between the radiator and person’s body
(excluding extremities: hands, wrists, feet and ankles).

This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to part
15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when
the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his own expense.

If this equipment does cause interference to radio or television equipment reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Move the equipment away from the receiver.

* Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.
¢ Consult the dealer or an experienced radio/television technician for additional suggestions.

Any changes or modifications to the equipment not expressly approved by the party responsible for
compliance could void your authority to operate such equipment.

Industry Canada Compliance

This equipment complies with IC radiation exposure limits set forth for uncontrolled equipment and meets RSS-
102 of the IC radio frequency (RF) exposure rules. This equipment has very low levels of RF energy that it
deemed to comply without maximum permissive exposure elevation (MPE). Bit it is desirable that it should be
installed and operated with at least 30 cm or more between the radiator and person’s body (excluding
extremities: hands, wrists, feet, and ankles).

This class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following
two conditions: (1) this device may not cause interference, and (2) this device must accept any interference,
including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de
licence. L’exploitation est autorisée aux deux conditions suivantes : (1) I’appareil ne doit pas produire de
brouillage, et (2) I'utilisateur de I’appareil doit accepter tout brouilage radioélectrique subi, méme si le brouillage
est susceptible d’en compromettre le fonctionnement.

IC RF Radiation Exposure Statement

When installing, locate or point this device away from the installer, so it does not emit RF field in excess of Health
Canada’s limits for the general population. Consult Safety Code 6 from Health Canada’s website at www.hc-
sc.gc.ca/rpb.

Regulatory P/N: 1006148-01 57



IC Additional Statement with Detachable Antennas

This device (with Digital UHF Il modem) has been designated to operate with the antennas listed below and
have a maximum gain of 2.4dBi. Antennas not included in this or having a gain greater than 2.4dBi are strictly
prohibited for use with this device. The required antenna impedance is 50 ohms.

Sokkia Atlas Digital UHF Il 2.4dBi whip antenna

Manufacture/Type

420-450 MHz LAIRD or ANTENEX/G420BN
450-470 MHz LAIRD or ANTENEX/G450BN

The device has been designated to operate with the antennas listed below and have a maximum gain of 2.1dBi.
Antennas not included in this or having a gain greater than 2.1dBi are strictly prohibited for use with this device.
The required antenna impedance is 50 ohms.

Community of Europe Compliance

The product described in this manual is in compliance with the R&TTE and EMC directives from the European

Community.

European Community Declaration of Conformity with R&TTE Directive

1999/5/EC

The following standards were applied: (R&TTE Directive 1999/5/EEC)

e ETSI EN 300 113-2 v1.5.1(2011-11)
e ETSI EN 301 489-1 v1.9.2(2011-09)
e ETSI EN 301 489-7 v1.3.1(2005-11)

« ETSI EN 300 440-2 v1.4.1(2010-08)

« ETSI EN 300 328 v1.7.1(2006-10)
« ETSI EN 301 489-3 v1.4.1(2002-08)
« ETSI EN 301 908-1 v5.2.1(2011-05)

e ETSI EN 301 489-5 v1.4.1(2002-08)

ETSI EN 301 489-17 v1.5.1(2010-10)

]

ETSI EN 301 511 v9.0.2(2003-03)

EN 60950-1:2006:+A11:2009 &
Al1:2010

EN 55022:2010

ETSI EN 301 489-24 v1.5.1(2010-10)

ETSI EN 301 908-2 v5.2.1(2011-07)

This equipment is intended to be marketed in the following countries:

List of National Codes:

e AT DE MT GB
* BEGRNLIS
e CYHUPLLI
e CZIEPTNO
e DKIT SK CH
e EELVSIBG
* FILT ESRO

* FRLUSETR

The equipment is labeled with a CE! mark that informs users the DIG UHFII frequency range 410-470 MHz is

not harmonized throughout Europe and the specific country spectrum authority should be notified before a radio

modem is used.

430,

Community of Europe Compliance

P/N: 1006148-01
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Use of this equipment requires a license.

L'impiego di questo impianto necessita una concessione.

Das Betreiben dieser Anlage unterliegt der Konzessionspflicht.

L'utilisation de cette installation nécessite une concession.

Declaration of Conformity (R&TTE Directive 1999/5/EC)

esky
[Czech]

Dansk
[Danish]

Deutsch
[German]

Eesti
[Estonian]

English

Espariol
[Spanish]

[Greek]

Francais
[French]

(Sokkia) timto prohlasuje, ze tento (Sokkia Atlas) je ve shod se
zakladnimi pozadavky a dalSimi pisluSnymi ustanovenimi smrnice
1999/5/ES.

Undertegnede (Sokkia) erkleerer herved, at fglgende udstyr
(Sokkia Atlas) overholder de veesentlige krav og gvrige relevante
krav i direktiv 1999/5/EF.

Hiermit erklart (Sokkia) dass sich das Gerat (Sokkia Atlas) in
Ubereinstimmung mit den grundlegenden Anforderungen und den
ubrigen einschlagigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

K&esolevaga kinnitab (Sokkia) seadme (Sokkia Atlas) vastavust
direktiivi 1999/5/EU pdhinduetele ja nimetatud direktiivist
tulenevatele teistele asjakohastele satetele.

Hereby, (Sokkia) declares that this (Sokkia Atlas) is in compliance
with the essential requirements and other relevant provisions of
Directive 1999/5/EC.

Por medio de la presente (Sokkia) declara que el (Sokkia Atlas)
cumple con los requisitos esenciales y cualesquiera otras
disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

ME THN MAPOYZA ( Sokkia )

AHAQNEI OTI ( Sokkia Atlas ). ZYMMOPO®ONETAI
MNPOZ TIZ OYZIQAEIZ AMAITHZEIZ KAI TIZ AOINEZ
ZXETIKEZ AIATAZEIZ THZ OAHITAZ 1999/5/EK.

Par la présente (Sokkia) déclare que I'appareil (Sokkia Atlas) est
conforme aux exigences essentielles et aux autres dispositions
pertinentes de la directive 1999/5/CE.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 1006148-01
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Italiano Con la presente (Sokkia) dichiara che questo (Sokkia Atlas) e OCQ
[1talian] conforme ai requisiti essenziali ed alle altre disposizioni pertinenti o
stabilite dalla direttiva 1999/5/CE. 8‘
Latviski Ar 30 (Sokkia) deklar, ka (Sokkia Atlas) atbilst Direktvas ~2
[Latvian] 1999/5/EK btiskajm prasbm un citiem ar to saisttajiem
noteikumiem.
Lietuvi Siuo (Sokkia) deklaruoja, kad 8is (Sokkia Atlas) atitinka esminius

[Lithuanian]

reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas.

Nederlands Hierbij verklaart (Sokkia) dat het toestel (Sokkia Atlas) in

[Dutch] overeenstemming is met de essentiéle eisen en de andere
relevante bepalingen van richtlijn 1999/5/EG.

Malti Hawnhekk, (Sokkia), jiddikjara li dan (Sokkia Atlas) jikkonforma

[Maltese] mal-tiijiet essenzjali u ma provvedimenti orajn relevanti li hemm
fid-Dirrettiva 1999/5/EC.

Magyar Alulirott, (Sokkia) nyilatkozom, hogy a (Sokkia Atlas) megfelel a

[Hungarian]

Polski Niniejszym, (Sokkia) , deklaruj, e (Sokkia Atlas) spenia

[Polish] wymagania zasadnicze oraz stosowne postanowienia zawarte
Dyrektywie 1999/5/EC.

Portugués (Sokkia) declara que este (Sokkia Atlas) esta conforme com os

[Portugues] requisitos essenciais e outras disposi¢des da Directiva 1999/5/CE.

Slovensko (Sokkia) izjavlja, da je ta (Sokkia Atlas) v skladu z bistvenimi

[Slovenian] zahtevami in ostalimi relevantnimi doloili direktive 1999/5/ES.

Slovensy (Sokkia) tymto vyhlasuje, Ze (Sokkia Atlas) spa zakladné

[Slovak] poziadavky a vSetky prislusné ustanovenia Smernice 1999/5/ES.

Suomi (Sokkia) vakuuttaa taten etta (Sokkia Atlas) tyyppinen laite on

[Finnish] direktiivin 1999/5/EY oleellisten vaatimusten ja sita koskevien
direktiivin muiden ehtojen mukainen.

Svenska Harmed intygar (Sokkia) att denna (Sokkia Atlas) star |

[Swedish] overensstammelse med de vasentliga egenskapskrav och 6évriga

vonatkoz6 alapvetd kévetelményeknek és az 1999/5/EC iranyelv
egyéb elbirasainak.

relevanta bestammelser som framgar av direktiv 1999/5/EG.

WEEE Directive

Following information is for EU-member states only:

The use of the symbol below indicates that this product may not be treated as household waste. By ensuring
this product is disposed of correctly, to help prevent potential negative consequences for the environment and
human health, which could otherwise be caused by inappropriate waste handling of this product. For more
detailed information about the take-back and recycling of this product, please contact a supplier where you
purchased the product or consult.

WEEE Directive P/N: 1006148-01 60




Bluetooth Transmission Statements/Compliance

This Bluetooth device is compliant to the following profiles of the core spec version 2.1/2.1+EDR:

* Baseband
* HCI
¢ Link Manager

¢ Radio
The radio has been tested using the maximum antenna gain of 2.3 dBi and the Bluetooth qualification is valid

for any antenna with the same or less gain.

A1ojen3ay
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Warranty

Sokkia positioning equipment are guaranteed against defective material and workmanship under normal use and
application consistent with this Manual. The equipment is guaranteed for the period indicated, on the warranty
card accompanying the product, starting from the date that the product is sold to the original purchaser by
Sokkia’s Authorized Dealers.!

During the warranty period, Sokkia will, at its option, repair or replace this product at no additional charge. Repair
parts and replacement products will be furnished on an exchange basis and will be either reconditioned or new.
This limited warranty does not include service to repair damage to the product resulting from an accident, disaster,
misuses, abuse or modification of the product.

Warranty service may be obtained from an authorized Sokkia warranty service dealer. If this product is delivered
by mail, purchaser agrees to insure the product or assume the risk of loss or damage in transit, to prepay shipping
charges to the warranty service location and to use the original shipping container or equivalent. A letter should
accompany the package furnishing a description of the problem and/or defect.

The purchaser’s sole remedy shall be replacement as provided above. In no event shall Sokkia be liable for any
damages or other claim including any claim for lost profits, lost savings or other incidental or consequential
damages arising out of the use of, or inability to use, the product.

1. The warranty against defects in a Sokkia battery, charger, or cable is 90 days.
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Glossary

B

Base Station — A GNSS receiver set up over a known point, which is used to derive correction information for
nearby Rover (mobile) GNSS receivers.

BeiDou- BeiDou Navigation Satellite System maintained and operated by China.

Bluetooth® — Often used in place of cables, Bluetooth is open wireless technology for exchanging data over short
distances from fixed and mobile devices.

G

GALILEO - The satellite system currently being maintained and operated by the European Union (EU) and
European Space Agency (ESA).

GGD — GPS + GLONASS Dual Frequency signal tracking.

GLONASS — The Global Navigation Satellite System maintained and operated by the Russian Federation.
GNSS — Global Navigation Satellite Systems, such as GPS and GLONASS.

GPS — The Global Positioning System maintained and operated by the United States Department of Defense.

L

L1 and L2- For the ranging codes and navigation message to travel from the satellite to the receiver, they must
be modulated onto a carrier frequency. In the case of the GPS design, two frequencies are utilized: one at 1575.42
MHz (10.23 MHz x 154) called L1 and the other at 1227.60 MHz (10.23 MHz x 120), called L2.

Light-Emitting Diode (LED) — Used as indicator lights on the receiver to display the status of the receiver’s
components and control receiver operations.

M
MAGNET® Field — Data controller software that is part of the MAGNET software system.

MAGNET® Office — Post-processing and CAD solution software for surveying and grade application. It is part of
the MAGNET® software system.

MINTER — The receiver’'s Minimum INTERface used to display and control data input and output.

N

Network RTK — Collects satellite observations from the reference stations within the network and sends RTK
corrections to the Rover.

0]

Option Authorization File (OAF) — This enables specific features for scalable performance of Sokkia GNSS
receivers.

P

Phase Center of Antenna — The point from which the electromagnetic radiation spreads spherically outward,
with the phase of the signal being equal at any point on the sphere.
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R

Real-Time Kinematic (RTK) — A precise method of real-time surveying. RTK enables you to check the
measurement quality without having to process the data.

Aiesso|H

Root Mean Square (RMS) — Statistical measure of the magnitude of a varying quantity.
Rover — A mobile GNSS receiver and data collector used for determining location in the field.

S

Satellite-Based Augmentation Systems (SBAS) — Complements existing global navigation systems.
SBAS transmits differential corrections and messages for navigation satellites that are within sight of a
network or reference stations in a wide area, such as a continent.

Sokkia Receiver Utility (SRU) — Receiver configuration software for receivers and peripheral devices.

Static Survey — Location determination when the receiver’s antenna is stationary. This method provides
the highest accuracy and requires the longest observation times.

U

Universal Serial Bus (USB) — A connection standard used by devices, such as a receiver, controller,
computer, etc.
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